Congratulations on your purchase of a Full Spectrum Laser FD Fiber Marking Laser. With proper usage and upkeep, your Fiber Marking Laser should provide years of productive output. This user manual will guide you through the safety guidelines and operation of your machine. It is recommend that you familiarize yourself with this manual before using your marking laser. For more information and product selection, please visit www.fslaser.com.
**Contents**

3 **SECTION ONE: SAFETY FIRST**

- Safety Icons
- General Safety
- Laser Safety
- Fire Safety
- Electrical Safety

7 **SECTION TWO: UNCRATING**

- Uncrating Your FD Fiber Marking Laser
- Unpacking List
  - A: FD Unit
  - D: Mouse
  - J: Small Phillips Screwdriver
  - K: Medium Phillips Screwdriver
  - L: Large Flathead Screwdriver

10 **SECTION THREE: INSTALLATION AND ASSEMBLY**

- Assembly Stage One: Connect Electrical Power
- Assembly Stage Two: Power Machine, Computer, and Monitor On
- Assembly Stage Three: Open Marker Software
- Assembly Stage Four: Establish Exhaust (Recommended)

11 **SECTION FOUR: USER INTERFACES & OPERATIONS**

- FD Fiber Marking Laser Machine Interface
- Focusing
- Using Your FD Fiber Laser Marker
- Using Marker Software
- WORK SPACE
- TOP LINE MENUS
  - SYSTEM BAR (LEFT) (EDIT MENU)
  - SYSTEM BAR (MIDDLE) (EDIT MENU CONT.)
  - SYSTEM BAR (MIDDLE) (EDIT MENU CONT.)

80 **SECTION FIVE: TESTS AND CALIBRATION**

- WORK SPACE CALIBRATION

86 **SECTION SIX: HARDWARE & MAINTENANCE**

- Replacing Lenses
- No Red Light In Work Area
- Demo Mode
- General Maintenance

89 **Appendix A: Software Download for Replacement Laptop/PC**

90 **Appendix B: Rotary Attachment Installation (Optional)**

93 **Appendix C: Warranty Information**

93 **Warranty**
SECTION ONE: SAFETY FIRST

It is the responsibility of the user to ensure all safety protocols are followed and all safety precautions are correctly assembled and working properly before operating the machine.

Safety Icons

Familiarize yourself with these icons. They indicate areas that require special attention.

General Safety

- **ALWAYS** have a clean, level and open work space to uncrate and place your fiber marking system.
- **NEVER** modify, disassemble, or in any way alter the construction of the laser and never start up a system that has been modified or disassembled.
- **ALWAYS** inspect the scan head for damage and breakage before use.
- **NEVER** leave the system unattended during operation.
- **KEEP YOUR LASER SYSTEM CLEAN** - A build up of engraving residue is dangerous and can create a fire hazard. Keep your marking system clean and free of debris.
- **DO NOT** disassemble the machine or remove any of its protective covers.
- **NEVER** place hands, fingers or objects into moving parts such as cooling fans.
- **NEVER CUT OR MARK PVC** (polyvinyl chloride) under any circumstances.
Laser Safety

NEVER operate the machine with any of the panels removed. Be aware that removal of any portion of the cabinet will expose the laser system and greatly increase the risk of injury.

NEVER mark or engrave any material containing PVC or vinyl. These materials (along with other chlorine/chloride containing materials) produce a corrosive vapor that is extremely harmful to humans and will destroy your machine. Your warranty will be void if your machine is damaged by corrosion from marking or engraving PVC or vinyl.

NEVER mark or engrave any unknown material. The vaporization/melting of many materials, including but not limited to PVC and polycarbonates, can give off hazardous fumes. Please refer to the MSDS sheet from the material manufacturer to determine the response of any work material to extreme heat (burning/fire hazard).

NEVER operate the machine without a properly operating ventilation system. Most materials produce an irritating smoke when engraved. Some materials, including but not limited to: paint, varnish, metals, and plastics produce compounds that can be harmful if concentrated.

NEVER look into the beam of the red visible laser.

NEVER aim any laser towards an aircraft or vehicle that is in motion. The bright light can flash-blind, cause glare, or distract the pilot or driver.

ALWAYS wear industry approved laser safety goggles when operating the laser. Your FD laser comes with one pair of laser safety goggles. It is recommended operators have a spare set and at least one set of goggles for each operator using the equipment.

The standard reference for laser safety is the American Standard for the Safe Use of Lasers, Z136.12000, developed by the American National Standards Institute (ANSI). This reference is the basis for many of the federal regulations for laser and laser system manufacturers, and for the Occupational Safety and Health Administration (OSHA) laser safety guidelines. It contains detailed information concerning proper installation and use of laser systems. While the ANSI standard itself does not have the force of law, its recommendations, including warning signage, training, and the designation of a laser safety officer, may be compulsory under local workplace regulations when operating laser systems above Class I. It is the operator’s responsibility to ensure that the installation and operation of the Full Spectrum Laser Hobby Laser System is performed in accordance with all applicable laws. Copies of ANSI Standard Z136.12000 are available from: LASER INSTITUTE OF AMERICA 12424 RESEARCH PARKWAY, SUITE 125 ORLANDO, FL 32826 (407) 3801553.
Fire Safety

Laser marking and engraving systems can present a significant fire hazard due to the extremely high temperatures generated by the laser beam. While the objective of most marking and engraving operations is to vaporize material without burning, some materials capable of being marked or engraved are inherently combustible and can ignite.

**ALWAYS** keep a properly maintained and inspected 5lb or larger fire extinguisher on hand. Full Spectrum Laser recommends a CO2 fire extinguisher or a multi-purpose dry chemical fire extinguisher. CO2 extinguishers are more expensive than a dry chemical, but offer certain advantages should you ever need to use an extinguisher. The CO2 extinguisher discharges a clean, easily removable substance that is not harmful to the mechanics or wiring of the Fiber system. The dry chemical extinguisher discharges a sticky, corrosive powder that is very difficult to clean up.

**NEVER** operate your machine unattended. There is a significant risk of fire if the machine is set improperly, or if the machine should experience a mechanical or electrical failure while operating.

**ALWAYS** keep the area around the machine clean and free of clutter, combustible materials, explosives, or volatile solvents as acetone, alcohol, or gasoline.

**NEVER** store any flammable materials in the inside of the device or in the immediate vicinity of the device. Debris and leftover produced materials within the machine must be removed to prevent fire hazard.

**ALWAYS** have on hand a first-aid kit designed for the initial treatment of burns and smoke inhalation. Be sure to store this kit in an area that is outside risk areas.

**ALWAYS** have an emergency plan in case of fire or accident. Be sure this plan is posted and known to all operators and visitors.

**Woodshop Dust Fire Safety Considerations**

Before processing materials the user must verify whether harmful materials can be generated and whether the filter equipment of the exhaust system is suitable for the harmful materials. We emphasize that it is the responsibility of the user, to consider the national and regional threshold values for dust, fogs and gases when selecting the filters and the exhaust system. (The values for the maximum workplace concentration must not be exceeded.)

Be mindful of large quantities of fuel in the form of wood and wood products, sawdust, and flammable materials such as paints, oil finishes, adhesives, solvents, and liquid propane for internal combustion engines.

Preventing the buildup of dust is one of the key means for controlling fire and explosion hazards. The principal engineering control technology for control of dust is exhaust ventilation. The primary work practice control is good housekeeping.

Dust collection is best accomplished at the source—at the point of operation of the equipment, if feasible. For many pieces of equipment, well-designed ducts and vacuum hoods can collect most of the dust generated before it even reaches the operator.
Very fine dust that manages to escape point-of-source collection can be captured from above by general exhaust points located along the ceiling. These control technologies are effective for most equipment, excepting machines that commonly produce the very finest dust or large quantities of dust.

*These guidelines come from the U.S. Department of Labor

---

**Electrical Safety**

The Fiber Laser’s power source utilizes a 24v diode-pumped solid-state laser to supply power through a fiber optic cable which then supplies power to the machine’s scan head. Additionally there are DC PSU’s present within the unit that receive 110v (220v optional) voltage to operate. Always make sure to unplug the machine from the power outlet before accessing the electronics area.

**DO NOT** open any of the machine’s access panels while the unit is plugged in. Opening a panel may expose the operator to the unit’s AC input power. The AC input power is potentially lethal and is located on the far right rear within the cabinet.

**NEVER** make or break any electrical connections to the system while the unit is turned on.

**NEVER** access the electronics area with hands or tools unless the unit is disconnected from power for at least one hour.

**POWER ON/OFF** is controlled by the laser button located on the dash for the power source as well as the breaker switch on the right side of the unit. To power the laser source down, simply press the laser button in until it pops into the off position and turns off or switch the breaker switch down on the side of the unit to power the machine off completely. To power the laser up, flip the breaker switch up and then press the laser button inward on the front of the machine so it lights up.

**IN CASE OF A BLOWN FUSE** determine the cause of the overload before replacement to protect the machine from damage.
SECTION TWO: UNCRATING

When your FD Fiber Marking Laser arrives, it will require careful uncrating and examination of parts. Follow these instructions for best results.

Uncrating Your FD Fiber Marking Laser

1. **Create a work space.** You will need an open, level work space to place your fiber laser. A space large enough (the machine’s dimensions are 23 3/4” x 36” x 56”) for the machine to be positioned is required. Be sure the work area is free of fire hazards and is well ventilated.

2. **Carefully remove the top and sides of the crate.** Set the create on a flat surface near where you will place the machine. Open the crate using a hand drill and 5/16” socket head bit to remove the screws holding the crate together. Start with the top of the crate and work down each side of the crate from there until the top and all 4 sides of the crate are removed. Be careful not to damage/strike the machine present within the crate during the uncrating process.

3. **Remove plastic wrap and accessory box from machine.** With the top and sides of the crate removed the plastic wrap covering the laser can be cut free via a utility knife and then removed. Once the wrapping is removed remove the accessory box on the top of the machine and place it to the side.

4. **Remove machine from pallet and place into work area.** There will be 4 studs securing the 4 leveling pads/feet of the machine to the pallet. Use a hammer and pry bar and remove each top stud. With all studs removed, lift the machine off of the pallet and place it into the desired work area. Be aware that the machine weighs 250 lbs. Find someone to help you lift it. The machine should now be positioned in your flat work area.

5. **Inspect the machine.** With the fiber unit and accessory box now out of the crate be sure to give the interior and exterior of the unit a thorough visual inspection for any defects or breakage. If you find any defects or breakage, contact your sales representative immediately. Have pictures of the damage ready to share. Your machine is now uncrated.
Unpacking List

The following items come standard with the shipment of the FD Fiber Marking System:

A: FD Unit
B: Lenovo PC Tower
C: Keyboard
D: Mouse
E: 17/19mm Wrench
F: 8/10mm Wrench
G: 5.5/7mm Wrench
H: Allen Wrenches
J: Small Phillips Screwdriver
K: Medium Phillips Screwdriver
L: Large Flathead Screwdriver
N: Footswitch
O: Safety Goggles

FD Fiber Marking Laser Parts List

Your laser shipped with the following included parts and accessories:

<table>
<thead>
<tr>
<th>DESCRIPTION (QTY)</th>
</tr>
</thead>
<tbody>
<tr>
<td>FD Fiber Marking Laser (1)</td>
</tr>
<tr>
<td>Lenovo Windows 10 Professional PC (1)</td>
</tr>
<tr>
<td>Keyboard (1)</td>
</tr>
<tr>
<td>Mouse (1)</td>
</tr>
<tr>
<td>17/19mm Wrench (1)</td>
</tr>
<tr>
<td>8/10mm Wrench (1)</td>
</tr>
<tr>
<td>5.5/7mm Wrench (1)</td>
</tr>
<tr>
<td>Allen Wrenches (1)</td>
</tr>
<tr>
<td>Steel Ruler (1)</td>
</tr>
<tr>
<td>Small Phillips Screwdriver (1)</td>
</tr>
<tr>
<td>Medium Phillips Screwdriver (1)</td>
</tr>
<tr>
<td>Large Phillips Screwdriver (1)</td>
</tr>
</tbody>
</table>

Additional Recommended Tools:

- Needle Nose Pliers (1)
- Foot Switch (1)
- Safety Goggles (1)
- Ignition Keys (1)

Optional Accessories (not included):

- Fiber Rotary Attachment

Pry Bar
Hammer
Utility Knife
SECTION THREE: INSTALLATION AND ASSEMBLY

With your fiber system uncrated and placed in its permanent work space we can now assemble it. This is a simple process that should take less than half an hour to complete. The following assembly stages will be described in detail:

Assembly Stages
Connect Electrical Power
Power Machine, Computer, and Monitor On
Open Marker Software
Establish Exhaust (Recommended)

Assembly Stage One: Connect Electrical Power
The Full Spectrum FD Fiber Laser and optional accessories are configured to accept 110VAC at 60Hz. 220VAC is an option that can be specified prior to purchase.

CONNECTING ELECTRICAL POWER STEPS:
Prepare Power Cord. Open rear compartment of FD machine and locate black power cord. Pull cord through port on machine and close rear compartment.
Plug in Power Cord to Outlet. Plug the power cord into any proper outlet socket in your workspace.

Assembly Stage Two: Power Machine, Computer, and Monitor On
All Full Spectrum FD Fiber Laser Systems come with a Lenovo PC and monitor pre-installed.

Connect Monitor. Position monitor screen and mounting arm so that it is easily view-able from the front of the machine and proceed to plug the power cord present on the top of the machine into the monitor. Then proceed with plugging the blue VGA cable into the monitor and secure it via a Phillips screwdriver.

Power Machine On. Power the machine on by flipping the breaker on the right of the machine into the up position. This will power on the machine, the laser source, the computer, as well as the monitor display.

Assembly Stage Three: Open Marker Software
Marker (ver. 2.14.9) is the control software that communicates with and controls the laser system. It is preinstalled on the Lenovo PC that is supplied with the FD Fiber System. Double-click the Marker software icon to run the software.

Assembly Stage Four: Establish Exhaust (Recommended)
Though not included, it is recommended that operators use an exhaust system to clear debris and fumes from the work area. This can be a simple exhaust fan that draws fumes from the point of operation, and expels them outdoors or into a filtered fume extractor. Ask your sales representative about exhaust recommendations or visit: https://fslaser.com/Products/LaserAccessories.
SECTION FOUR: USER INTERFACES & OPERATIONS

FD Fiber Marking Laser Machine Interface

The front interface of the FD fiber machine allows you to power the machine PSU’s, laser source, as well as optional rotary attachment on.

Ignition. The FD Fiber Laser System comes with a set of ignition keys. In order for the laser to receive power, the included key must be inserted and turned.

Red Dot Diode Brightness. This is a dial that can be turned to increase (clockwise) or decrease (counter-clockwise) the intensity of the red dot diode. Note this has zero affect on the power of the invisible marking laser.

Laser Source Power ON/OFF. This button turns the laser on and off. To power the laser up, flip the breaker switch up and then press the laser button inward on the front of the machine so it lights up. To power the laser source down, simply press the laser button in until it pops into the off position and turns off or switch the breaker switch down on the side of the unit to power the machine off completely.

Rotary Switch. This switch tells the system if the rotary is on (right position) or off (left position). Rotary systems are sold separately and must be installed (see appendix).

E-Stop. This is your Emergency Stop. If you need to immediately cut power to the laser’s ability to fire, hit the E-Stop. To allow the laser to fire again, you will need to reset the E-Stop by turning it until it “pops” out. From here, you can push it again to stop the laser output.

Foot Switch: Pressing the footswitch will initiate the current job in the software to start marking. This is a convenient way to keep your production at maximum when outputting one design over and over.
FOCUSBING

Ensuring the scan head is in the proper focus distance from the material is vital when attempting to optimize output. An out of focus laser beam will prevent the 1064 nm beam from properly marking the material regardless of parameter setting. The following instructions will assist with obtaining focus:

First, measure the thickness of the material the user intends to mark onto. Once that measurement is obtained focus is easily obtained from there. Below is an image illustrating the scan head and focus stand of the FD unit:

As illustrated on the focusing stand, there are a series of numbers increasing numerically located on the focus stand. Those numbers indicate the focus distance. The device that the scan head rests on and travels in the Z axis contains a flag that points to the numbers which is used to set a specific focus distance. With the standard 163 F Theta Lens installed for 20w systems the flag will need to be set at ~268mm on the focus stand to focus the scan head to the base plate. That measurement can vary lens to lens so a Notepad file is supplied on the computer received with the machine that contains the exact focal measurement for the lens installed into the machine. This file is located in the Documents portion of the computer and will have a number in mm’s stating focus. Now that the user knows where the focus point is at to the base plate, they can now take the material’s thickness and add that unit in millimeters to the current ~268mm value to set focus. For example, the item intended to be marked is 6mm thick.

Raise the scan head via the black crank located at the top of the focus stand until the flag points at ~274mm and that will be the correct focus for that specific material. As the thickness of the material will increase the scan head will need to be raised accordingly.
Using Your FD Fiber Laser Marker

A typical job starts with the creation of a design in Marker or importing a pre-existing bitmap or vector file into the Marker software. The following is a typical workflow for each time you run a job:

1. **Power On Machine.** Flip the red power switch on the side of the machine to the “Up” position. This will turn on the power to the machine and PC, and begin to boot the computer. Wait for Windows to load.
2. **Open Marker.** Double-Click the Marker shortcut on your computer’s desktop and allow program to open.
3. **Create Design.** There are several different design tools that can assist with creating vector lines within Marker. If you have a preexisting file you want to use instead, go to step 4.
4. **Import Design File.** If a design is already created, select “File” in Marker and then select “Import Bitmap File…” if you are wanting to etch a bitmap. Select “Import Vector File…” if you want to etch a vector file. This will open a search window for you to locate the file you want to work with. DXF files are the most common file used and are recommended to be used when working with Vector files.
5. **Remove Lens Cap.** Ensure lens cap is removed so material alignment and beam output can be completed.
6. **Focus.** You can now ensure that the focus lens is in proper focus to your material.
7. **Position Material.** Use the red beam as a guide to position your material to the laser by having a vector or bitmap loaded and pressing the F1 key on your keyboard. Never mark any unknown material without first consulting the manufacturer or MSDSonline.com. NEVER cut or mark PVC.
8. **Set Marking Parameters.** Your parameters will depend on the specifics of the project. We suggest doing material testing prior to starting a new job for the first time.
10. **Start Job.** You can begin the job by pressing the footswitch. Alternatively, you can click F2 on your keyboard or click the “Mark” button in the software. Once the laser has started operating, it will need to be closely monitored by the operator. Never leave a working laser unattended. Never operate the marking system without wearing the supplied safety goggles.

Shutting Down Your FD Fiber Laser Marker

Once you are done using your laser for the day, shut down the systems in the following order:

1. **Turn off the PC.** Access your Windows operating system on the computer and “shut down” the computer with the power option icon. It is never recommended to just turn off power.
2. **Check Laser is Off.** Check that the computer is shut down by ensuring that the light on the front of the monitor display is now orange instead of green.
3. **Shut Down Power.** You can now push the red power switch to the “down” position and depower the machine. By using this order to shut down, the PC will boot properly when the system is turned back on.
Using Marker Software

Marker 2.14.9 is the control software that communicates with and controls the laser system. Files compatible with Marker are bitmap, .dxf, .svg, .tiff, and other common image and design files.

Marker Software Interface
In this section you will be introduced to the major interface features of Marker.

WORK SPACE
The workspace window shows a preview of your current job.
TOP LINE MENUS

FILE
The File menu allows the user to open, import, or saves files within Marker.

File Sub-Menus:
- New
- Open
- Save
- Save As
- Import Vector File
- Import Bitmap File
- Print
- Scan Images
- System Parameter
- Image Library

The File sub-menu allows you to create a new blank document or open an existing project already saved, save any changes you have made to a project or save the project to a specific place, import either vector or bitmap files intended to be outputted by the laser, print what is currently present on the software window to a printer, scan images into the software from recording devices installed into your computer, open and adjust system parameters, refer to previous images scanned into the software, and open recent projects that were used.

EDIT
The edit menu allows you to edit an existing project within the Marker software.

Edit Sub-Menus:
- Undo Delete
- Redo
- Cut
- Copy
- Paste
- Combine
- UnCombine
- Group
- UnGroup
- Hatch
- To Curve
- To Dashed
- Offset
- UnGroup Text

The Edit sub-menu allows you to edit current projects being worked on in the Marker software by allowing the user to undo a delete action, redo a previous action, cut a portion of a file to be pasted elsewhere, copy a file to be pasted elsewhere, paste a file that has been either copied or cut, combine two or more items into one, uncombine items that have been previously combined, group items together, ungroup items that were previously grouped, hatch a vector file, convert a shape or text to a curve, convert a shape to dashes, create offset curves around an object, or to ungroup text.
**DRAW**
The Draw menu allows you to create a series of points, shapes, and other characters in a project.

*Draw Sub-Menus:*
- Point
- Curve
- Line
- Rect
- Circle
- Ellipse
- Polygon
- Text
- Bitmap File
- Vector File
- Time
- Input IO
- Output IO
- ExtAxis
- Encoder Distance
- Spiral

The Draw sub-menu allows the user to create specific characters in a project such as points, curves, lines, rectangles, circles, ellipses, polygons, text, bitmap files, vector files, time delays, input IOs, output IOs, add an external axis, add an encoder, or create a spiral.

**MODIFY**
The Modify menu allows you to change specific object properties.

*Modify Sub-Menus:*
- Array
- Transform
- Plastic
- Distribution
- Resort
- Trim
- Curve Edit
- Align
- Jsf Font

The Modify sub-menu allows you to modify object properties such as array an item, transform the item position, plastic which allows users to weld design objects together, distribute items, trim objects, edit an item’s curve, align, or convert objects to font.
**VIEW**
The View menu allows you to specify tools within the software or hide tools you do not want to use.

*View Sub-Menus:*
- System Bar
- Zoom Bar
- Draw Bar
- Status Bar
- Object List
- Object Property
- Mark Parameter
- Ruler
- Grid
- Guild Line
- Snap Grid
- Snap Guild Line
- Snap Entity
- IO State

The View sub-menu allows the user to show or hide specific portions of the software as they are needed such as object properties, drawing tools, object lists, the grid in the work area, the ruler showing the size of items, etc.

**SPECIAL**
The Special menu allows the user to refer to specific settings within the machine parameters as well as set up fly marking.

*Special Sub-Menus:*
- Change text
- SN text
- IPG Settings
- Read face3d from file

The special sub-menu allows you to change default text, add/remove/reset serial number text, and refer to IPG settings and configurations.
**LASER**
The Laser menu allows you to adjust specific laser parameters depending on your application and accessories being used.

*Laser Sub-Menus:*
- AngleRotate
- AngleRotate2
- MultiFileMark
- PowerRuler
- RingTextMark
- RotaryMark
- RotateTextMark
- SplitMark2
- ProjectMark

The laser sub-menu allows the user to utilize a rotary and perform specific rotary applications such as angle rotating, ring marking, rotating text marking, and as well as other operations.

**HELP**
The Help menu allows you to refer to your software version.

*Help Sub-Menu:*
- About
NEW DOCUMENT
Open a new document, if needed. If current document is not saved when this button is pressed the software will prompt you to save your work before opening a new document.

OPEN PROJECT
Open a document previously saved. If current document is not saved when this button is selected then the software will prompt you to save your work before opening a new project.

SAVE PROJECT
Save your current job as an .ezd or Ezcad file. Once saved that file can be opened again using the “Open Project” button.

CUT
When an item within your design is selected this button allows you to cut the item out of the project and paste it if desired in another location.

COPY
When an item within your design is selected this button allows you to copy that item to be pasted in another location of your project if desired.

PASTE
Select an item as cut or copied, and then paste it to a desired location within your project.

UNDO
Undo a previous action made while working on your project.

REDO
Redo an action that was undone while working on your project.
COMBINE
Select two or more items within your project and combine them to create a single item.

UNCOMBINE
Uncombine two or more items that were combined previously within your project.

GROUP
Group one or more items together within your project.

UNGROUP
Ungroup two or more items that were grouped previously within your project.

HATCH
Select to highlight a vector item within your project and then hatch it. This creates a series of vector lines within the vector design to be etched. The object to be hatched must be a closed curve. If multiple objects are to be hatched they can not intersect.

Once the “Hatch” button is selected a hatch dialog box will appear as shown below:

MARK CONTOUR
This check box determines whether to show and mark the selected object’s contour or not.

: With this button showing the laser will mark the hatch portion of the object first and then the contour afterward.

: With this button showing the laser will mark the contour portion of the object first and then the hatch afterward.

Hatch 1/ Hatch 2/ Hatch 3
You may have three independent hatch parameters to hatch the same object at the same time. Each set of hatch parameters can be assigned a Pen No. which appoints a set of marking parameters.
Enable
This check box determines whether to permit one of the three hatch parameters.

All Calc
This check box is an optimizing option that calculates all the selected objects as a whole. If this is not checked the objects selected will be calculated separately. An example of this is if you have three rectangles selected and hatched with “All Calc” not checked, the laser will etch the first rectangle, then the second, and then the third. If “All Calc” is checked then all three rectangles will be hatched at the same time on the same lines.

Follow Edge Once
This check box allows you to draw a single outline around the hatched image after filling.

(The left object does not have Follow Edge Once checked while the right does)

HATCH TYPE
Selecting the Hatch Type button will allow you to switch between the following hatch types:

Bidirectional Hatch
Hatch lines will be marked from left to right first, and then from right to left.

Unidirectional Hatch
Hatch lines will be marked from left to right.

OD- ID Hatch
Hatch fills object from outside to inside.

Dashed Hatch
Hatch fills the object with perforated hatch lines.
EXAMPLES OF HATCH TYPE

ANGLE
The hatch angle determines the angles between hatch lines and the X axis.

LINE DISTANCE
Determines the space between two hatch lines.

AVERAGE DISTRIBUTION LINE
The ability to allow start and end offsets is based on this check box. When checked, the software automatically adjusts the hatch line distance to the settings you specified and will set the hatch lines to an average distance.

EDGE OFFSET
This setting determines the distance between the hatch lines and the edge of an object's outline.
START OFFSET
Controls the distance between the first hatch line and the border of the object.

END OFFSET
Controls the distance between the last hatch line and the border of the object.

LINE REDUCTION
Controls the line reduction on both sides of the hatch lines.

NUMLOOPS
This setting controls the number of OD - ID hatch lines are completed before the Unidirectional or Bidirectional hatches are completed within the same object.
AUTO ROTATE ANGLE
Open to refer to after every mark, the hatch line will fill with a revolving angle which is set automatically to mark again. For example, if the angle is set to 0 and the check box is checked, the auto rotate angle is specified to 30. The first mark angle will be 0, the second 30, and the third 60, and so on.

: SYSTEM PARAMETERS
Open to refer to your software parameters. From here you can adjust the display, language, workspace, etc. Once selected the following menu will appear:

GENERAL
Under the General tab common parameters can be adjusted.
- **Unit Type**: Change between mm and inches as your unit type.
- **Paste X and Paste Y**: Set the relative offsets to a previously pasted object.
- **Grid**: Check to show or hide the grid within the software.
- **Grid Distance**: Adjust the distance within the grid in the work area.

COLOR
The color tab allows you to set the colors of the software's background, workspace, guide line and grid, etc. Double click the color stripe will allow you to change the setting to your desired color.
WORKSPACE
The workspace tab allows you to specify what type of workspace is desired as well as control the size of the workspace.

- **Show Workspace**: Check or unchecked to show or hide the workspace present within Marker.
- **Circle Workspace**: Check or uncheck to illustrate a square or circle workspace within Marker.
- **Show Center Cross Line**: Check or uncheck to illustrate a center cross line within the workspace.
- **Left Bottom Center**: Set what the center of the workspace offset is going to be.
- **Size**: Set the exact size of the workspace.

AUTOSAVE
The autosave tab allows you to specify a specific time between autosaves to be saved to your Marker directory.
MOVE ROTATE
These settings allow you to optimize specific options when adjusting objects.

- **Nudge Distance**: Increase or decrease this setting to control the distance an object moves when using the directional keys each time they are pressed.
- **Big Nudge Scale**: Set a distance that multiplies the nudge distance when holding the “shift” key and pressing the directional keys to allow an object to jump that distance.
- **Rotate**: Specify the angle an object rotates here so that when holding the “ctrl” key and using the directional keys the object will rotate at that desired angle.
- **To Origin**: Specify when using the “put to origin” function which point of the object is set to the origin.

PLUG Manager
This tab displays the Marker softwares plugs which have already been installed into your computer. You can activate or deactivate each plug.

Language
Adjust the language you want the software to use when opened.

- **S/H OBJECT LIST**: Show or hide the object list function.

- **Re-Sort**: Adjust the marking order the laser will perform when marking.

- **Mark Rows**: Laser will mark in rows order.
- **Mark Columns**: Laser will mark objects in columns order.
ZOOM BAR

- **ZOOM WINDOW**
  Right click the workspace to zoom out and left click the workspace to zoom out of the work area.

- **ZOOM PAN**
  Click and drag on the work space to pan the window around.

- **ZOOM IN**
  Click on the work area and zoom in onto an object.

- **ZOOM OUT**
  Click on the work area and zoom out away from an object.

- **ZOOM ALL**
  Select this button and the window will automatically zoom onto all of the items present within the work area.

- **ZOOM PICK**
  Zoom in onto selected object.

- **VIEW WORKSPACE**
  Select the window to automatically zoom in or out so that the entire workspace is visible.
COMMAND TOOLBAR

- **SELECT ALL**
  Select all objects present within the workspace.

- **SELECT/DESELECT ALL**
  Select all objects as well as deselect all objects within the workspace.

- **DELETE ALL**
  Delete whatever object(s) are selected within the workspace.

- **LOCK OBJECT**
  Lock a selected object and prevent it from being adjusted.

- **UNLOCK OBJECT**
  Unlock a previously locked object within the workspace.

- **UNLOCK/DESELECT OBJECT**
  Unlock and deselect a previously locked object within the workspace.

- **PUT TO ORIGIN**
  Selected object or objects will be set to origin within the work space. The origin can be adjusted in the system parameters menu or in the Object Properties menu.

- **PICK BY PEN**
  Select object by their pen color. If you have an object or objects set to a specific color and you would like that object(s) selected you can select this button and choose the pen you are looking to select and press OK.

- **VERTICAL MIRROR**
  Mirror the selected object in the X axis.

- **SHOW OBJECT**
  Show selected hidden object(s).

- **HORIZONTAL MIRROR**
  Mirror the selected object in the Y axis.

- **HIDE OBJECT**
  Hide selected object(s).
The Object List is located in the left side of the main interface window. Marked objects are grouped into an object structure or ungrouped into many objects. During the marking process the system will follow the order the objects are present within the Object List. Users can rearrange the list by dragging the object up and down. Additionally you can double click an object in the Object List to assign a name to the object.

The Object Properties are displayed in the left side of the main interface window below the Object List.

X Position: The X coordinate of the point in the center of the object selected.
Y Position: The Y coordinate of the point in the center of the object selected.
Z Position: The Z coordinate of the object selected.
X Size: The width of a selected object.
Y Size: The height of a selected object.

Lock: Lock the current width/height proportions of the selected object. When locked if you change the object’s size the system will keep the X/Y ratio. Clicking the button will switch between locked and unlocked states.

Coordinate: The coordinate data (X position, Y position) is mapped to a specific point of an object.
Array: Copy a selected object and arrange it to the destination you want by setting the row/column number and space.

**Array Example, X=2, Y=3**

**Count X:** Set the row count  
**Count Y:** Set the column count  
**Inc [mm]:** Set the space between each row/column

INPUT/ I/O Control Conditional: The system reads the input port first and then confirms whether the current input signal is the same as the object's “I/O Control Condition”. If it is, the current object will be marked, or, the system will skip the current object and mark the next object depending on what is checked. Only four bits are available currently. Each bit has three states. The grayed state means skip this signal. The unchecked state means that if you want to mark the object then the signal of this bit must be low level voltage (TTL compatible). The checked state stands for high level voltage (TTL compatible) being needed.

**NOTE:** After changing the parameters in the Object Properties you must click “Apply” to update the changes made.
**DRAWING TOOLBAR (DRAW MENU)**

- **SELECT TOOL**
  Select objects as well as other options within the software. When the tool is in the “pressed-down” state that indicates that the tool is currently being utilized. You can now use your mouse to select objects within the workspace.

- **EDIT NODE TOOL**
  Edit nodes within selected objects. When an object is selected in the workspace there will be nodes that appear around the object. Nodes are shown as hollow squares, the largest being the start point of the curve. When this tool is selected a Node Editing Toolbar will appear as shown below:

  - **Add Node:** When you select any point on a curve where there is no node a black solid circle will appear. Add node by clicking that the add node icon.
  - **Delete Node:** When you select a node on a curve it will become black. Select this icon to delete the node.
  - **Combine Nodes:** If nodes are close enough you may select a series of nodes and use this icon to combine them.
  - **Separate Nodes:** When you select a node on a curve the node will become black where you can then select this icon to separate the node into two separate nodes.
  - **Curve to Line Tool:** Select any position between two neighboring nodes and select this icon to make a curve (line/arc/curve) between two nodes a line.
  - **Curve to Arc Tool:** Users may select any position between two neighboring nodes and select this icon to make a curve (line/arc/curve) between two nodes an arc.
  - **Line to Curve Tool:** Convert a line between two points to a curve. You may select any position between two neighboring nodes and select this icon to convert the line between two nodes to a curve.
  - **Sharp Node Tool:** Convert a node to a sharp. This will allow users to sharpen curves.
**Smooth Node Tool:** Selected node will be changed into a smooth curve.

**Symmetry Node Tool:** Make a curve symmetrical. If you select a node and then select this icon the curves on both sides of the node will become symmetrical.

**Direction Tool:** Change the direction of a curve by exchanging the start and end points for the curve.

**Close Curve:** This tool is used to close a curve.

**Align Node Tool:** When you select multiple nodes you can select this icon which will bring up a dialog box where you can choose ways of aligning the nodes to top, bottom, left, and right of each other.

**NOTE:** You will not be able to edit nodes on text objects and hatch objects; only curves.

**DRAW LINE TOOL**
Draw a single line or create an object out of line segments. To do this select this icon and then click on the work area. Once the work area is select that beings the first segment of the line. You can then select any other point in the workspace and that will create a line. If you select the “Pick” tool at this point that will leave the line you created. If you keep the Draw Line Tool selected and proceed to select different portion of the workspace you will begin to create an object.

**DRAW CURVE TOOL**
Create a free curves by selecting this icon and click and dragging on the workspace. You will also be able to move the mouse to nodes on curves present and left click the mouse to delete nodes. Additionally you can move the mouse to a node at the beginning of the curve and left click it to close the curve automatically as well as move the mouse to a node at the end of a curve and left click to convert the node to a sharp. Finally you will also be able to position the cursor on points which are not nodes on the curve and left click to add a node at the corresponding point on the curve.
**RECTANGLE TOOL**

Draw a rectangle by left clicking in the work area and dragging to the right. You will be able to draw a square by left clicking on the work area while holding the “ctrl” key in unison while dragging to the right to create the size square desired. After drawing a rectangle the following toolbar will appear under the Object Properties:

- **Round**: Round the corners of a rectangle a specific degree.

  ![Round](image)

- **Arc Radius**: Refers to the smooth degree of a rectangle’s four corners. When the degrees are 100% the rectangles become circles.

- **All Corner Round**: Change the angles of the four corners at the same time just by changing one.

**NOTE**: After changing the parameters in the Object Properties you must click “Apply” to update the changes made.

**CIRCLE TOOL**

Draw a circle by left clicking the workspace and dragging to the right until you reach the desired size of the circle. When you draw and select the circle the following toolbar will appear under the Object Properties:

- **Diameter**: Diameter of the circle.

- **Start Angle**: This is the angle of the start point and the center of a circle

  ![Diameter](image)

  ![Start Angle](image)

  ![Clockwise](image): This icon indicates the drawing direction of the circle is clockwise.

  ![Counterclockwise](image): This icon indicates the drawing direction of the circle is counter-clockwise. Clicking on the icon switches the selection from clockwise to counterclockwise.
**ELLIPSE TOOL**

Draw a circle by left clicking the workspace and dragging to the right until you reach the desired size of the ellipse. When you draw and select the ellipse the following toolbar will appear under the Object Properties:

- **Start Angle:** The angle between the start point and center point of the ellipse.
- **End Angle:** The angle between the end point and the center of the ellipse.

- Indicates the drawing direction of the ellipse is clockwise.
- Indicates the drawing direction of the ellipse is counter-clockwise.

**POLYGON TOOL**

Create a series of different shapes that have more than 2 sides by left clicking the workspace and dragging to the right until you reach the desired size of the shape. When you draw and select the shape the following toolbar will appear under the Object Properties:

- **Edge Num:** The field indicates the number of the polygon’s borders which will be 3 or more but typically less than 10 as shapes with more than 10 sides look more like a circle.

- When selected, the current polygon to be drawn will be a convex polygon.
- When selected, the current polygon to be drawn will be a star.
TEXT TOOL
Create text directly within the workspace by selecting the text icon and left clicking once on the workspace. When you create and select the text within the work area the following toolbar will appear under the Object Properties:

Font Character Properties
Users may change the characters of the text by selecting the text within the text box and customizing. Marker supports five types of text. When you try to select a type of font a font list will appear to show all fonts available as shown:

When users select a type of font a list of available fonts within that font type will appear as shown below for TrueType Font:
**Height:** Set the height of the text characters.

: Hatch the text files after they are created using the hatch features.

: Open the font properties window as shown:

: Select to align current text to the left.

: Select to align current text to the center.

: Select to align current text to the right.

**Bold:** Check to make text bolded.

**Italic:** Check to make text italicized.

**Enable the Same Width Character:** When checked, the text characters will all have the same width.

**Char Width:** Set average width of the characters.

**Char Angle:** Set the degree at which the characters incline.

**Char Space:** Set the distance between the characters.

**Line Space:** Set the distance between the character rows.

**Empty Char Width:** Illustrates the percentage of empty characters.

**Orientation:** Choose to align the text vertically or horizontally.
Circle Text Function
This function will allow you to create text that aligns in accordance to the diameter of a circle.

Circle Text: When checked, the text box created will use the following parameters.

Circle Diameter: Specifies the diameter of the circle you intend to have the text follow.

Base Angle: represents the baseline angle of the text.

Angle range limit: this setting sets the range the base angle settings can be set to. If set, no matter how many characters are inputted the system will compress all the characters to be within the limit range.

: When on, Circle Text will mirror the text vertically.

: Flip the text to start from end to beginning.
**Circle Text Function**
This function will allow you to create text that aligns in accordance to the diameter of a circle.

**Circle Text**: When checked, the text box created will use the following parameters.

**Circle Diameter**: Specifies the diameter of the circle you intend to have the text follow.

**Base Angle**: represents the baseline angle of the text.

**Angle range limit**: this setting sets the range the base angle settings can be set to. If set, no matter how many characters are inputted the system will compress all the characters to be within the limit range.

: When on, Circle Text will mirror the text vertically.

: Flip the text to start from end to beginning.
**Curve Text Function**

If you draw text onto a curve by clicking the text icon, and then clicking on the curve, the text will align along the curve. When the text aligns to the curve this icon, 🎨, will appear and if selected will bring up the following window:

- **Flip/Mirror**: Flip/Mirror the text on onto the other side of the curve.

**Transform**: Adjusts the way text contacts the curve.

**ABCD Normal**: When selected, the text will stay parallel with the curve as shown:

**ABCD Project**: When selected, the text will stay vertical in correspondence with the curve as shown:
**Base:** Control how text is aligned onto the curve:

- **Base**
  - Sets the base of the text to the curve as shown in the ABCD Normal figure.

- **Bottom**
  - Sets the very bottom of the text to the curve.

- **Center**
  - Sets the center of the text onto the edge of the curve.

- **Top**
  - Sets the top of the text onto the bottom edge of the curve.

- **Free**
  - Sets the text freely onto the curve which allows for free adjustment. The offset length can be adjusted, if selected.

**Base Length:** Controls how far away the left edge of the text is away from the left edge of the curve.

**Offset Length:** Controls how far away the base of the text is offset from the curve line.

![Diagram of text alignment on a curve](image-url)
**Variable Text**
This function is available after the “Enable variable text” box is checked as shown below. Variable Text is a disciplinary and dynamic text which can be customized during operation.

: Set the adjacent character distance in the current text character arrangement.

: When selected, the adjacent character spacing refers to the left side of the character right boundary to the right side character left boundary distance as shown:

: When selected, the adjacent character spacing refers to the left side of the characters center, to the right side of the characters center distance, as shown:

: The array function is specific to variable texts as when it is used the text will change automatically, but the text object will not change.
Within Marker the variable text is a character string that increases the order by each different real-time change to the text element. As needed the user can increase each kind of variable text element to carry a rank order on that text element. Once the “Variable Text” box is checked and “Add” is selected a dialog box will appear as shown below:

There are 8 types of variable text currently supported by Marker:

- **Fixed Text**: Refers to the fixed invariable element within the operating process.
- **Serial Number**: Specify the system to change the text according to the fixed increments when in the operating process.
- **Date**: When the operation is taking place, the system will automatically pick up the date information from the computer as new text.
- **Time**: When the operation is taking place, the system will automatically pick up the time information from the computer as new text.
- **TCP/IP Communication**: When the operation is taking place, the system will pick up the new text from the network.
- **Serial Communication**: When the operation is taking place, the system will pick up the new text from the serial port.
- **File**: The system will seriatim what to be marked in the customized text file line by line.
- **Keyboard**: Type text to be marked through keyboard when the marking is in process.
Serial Number
Serial number text is a text which is changed according to the fixed increments set during the operating process. When selected, a serial number parameter setting page will automatically appear as shown:

- **Start**: Indicates what number the system will start with during the operating process.
- **Current**: Indicates what current number the system is ready to mark during the operating process.
- **Limit**: This number indicates a max value during the serial number operating process.
- **Increment**: Determines what increments the serial number value will increase by per mark.
- **Marks Per**: Specifies the number of mark loops per etch during the operating process.
- **Mode**: Specifies the mode of the current number series being used.
  - **Dec**: Number series used apply to decimal system. The effective character starts from 0 to 9.
  - **HEX**: Number series used apply to capital letter hexadecimal system. The effective character starts from A to F.
  - **hex**: Number series used apply to lowercase letter hexadecimal system. The effective character starts from a to f.
**Date**
When the operation is taking place, the system will automatically pick up the date information from the computer as new text. When selected a date parameter window will be shown in a dialog box as shown:

![Date Parameter Window](image)

**Year-2017**: Uses the computer clock’s current year for corresponding text. Four characters are used to specify the year.

**Year-17**: Uses the computer clock’s current year for corresponding text. Two characters are used to specify the year.

**Month-06**: Uses the computer clock’s current month for corresponding text. Two characters are used to specify the month.

**Day of Month-21**: Uses the computer clock’s current date of month for corresponding text. Two characters are used to specify the date.

**Day of Year-172**: Uses the computer clock’s current date for corresponding text. January 1st is specified as 001, January 2nd is 002, etc. Three characters are used to specify the date.

**Day of Week-03**: Uses the computer clock’s current week date for corresponding text. Two characters are used to specify the day of week.

**Week of Year-25**: Uses the computer clock’s current week of year for corresponding text. January 1 to January 7 is specified as 01, January 8 to January 14 as 02, etc. Two characters are used to specify the week of year.

**Date**: Specify a displacement date to be marked using this setting. This is commonly used for guaranteeing food expiration dates.
**Time**
When the operation is taking place, the system will automatically pick up the time information from the computer as new text. When selected the time parameter window will be present in the dialog box as shown:

- **Hour-24**: Uses the computer clock’s hour for the corresponding text. This time format uses the standard 24 hour setting.
- **Hour-12**: Uses the computer clock’s hour for the corresponding text. This time format uses a 12 hour setting.
- **Minute**: Uses the computer clock’s current minute for the corresponding text.
- **Second**: Uses the computer clock’s current second for the corresponding text.
- **Time Section**: Divides a 24 hour day into 24 time sections, allowing the user to define each time section as text.
TCP/IP Communication
When the operation is taking place, the system will pick up the new text from the Network. Notice: The network interface shown, is the network interface used in the TCP/IP agreement. When selected a parameter window shown below will appear in the dialog box, as shown:

![Parameter Window]

**IP Address:** Specify IP Address which data is read from.

**Port:** Specify the port that the TCP/IP communication uses.

**Command:** When the laser system processes this text object, the system uses. the network interface to transmit this specific character string order to a computer assigned by the IP Address. From there the computer processes the string order sent. The system will not start until the computer replies. After the response is received the laser system will process the response text automatically.

**Unicode:** when box is checked the fiber system recognizes the characters in Unicode form rather than ASCII form.
Serial Communication
When the operation is taking place, the system will pick up the new text from the serial port. When selected the following parameter window will appear in the dialog box as shown:

![Parameter Window]

- **Port:** Select the port with which the computer and peripheral equipment connect with.

- **BaudRate:** Select the BaudRate with which the serial communication utilizes.

- **DataBits:** Select the DataBits with which the serial communication utilizes.

- **StopBits:** Select the digits of StopBits with which the serial communication uses.

- **Parity:** Select the digits of Parity with which the serial communication utilizes.

- **Command:** When the laser system processes this text object, the system uses the serial port to transmit this specific character string order to a specific peripheral equipment. From there the peripheral equipment processes the string order sent. The system will not start until the peripheral equipment replies. After the response is received the laser system will process the response text automatically.

- **Unicode:** When box is checked, the fiber system recognizes the characters in Unicode form rather than ASCII form.
File
Marker now supports TxT and Excel files.

1. TxT Files
When “File” is selected and TxT highlighted, the following parameters will appear in the dialog box as shown. As displayed the system will ask for the “File Name” and the current text line number.

![TxT Dialog Box]

**Auto Reset:** when checked the line number will change to 0 automatically when the last line is reached. The next mark will start from the first line again.

**Read All Lines:** when checked the laser system will process the entire document.

2. Excel Files
The file name, field name, and line number will tell the software which cell within the excel table will be marked.

![Excel Dialog Box]

Keyboard
The Keyboard option allows the user to process text via keyboard entries. When the Keyboard option is selected the following is shown within the dialog box:

![Keyboard Dialog Box]

**Prompt:** When the process starts, the system will open a dialog box to have you input the processing text that will match the keyboard variable text input.

**Fixed Char Count:** Check and specify the number of characters within the string.
This tool will allow you to import a bitmap file previously saved onto your computer. You can also access bitmaps via the Draw menu or importing them via the File menu. Once you go to select a bitmap file the following window will appear:

After the desired image is brought into the Marker software, the following dialog will appear below the Object Properties:

**Dynamic File:** When checked, it will allow the system to reread the file at a different position.

**Fixed DPI:** “DPI stands for “Dots Per Inch”. When selected the system will allow you to set an unfixed X/Y DPI that you can specify. The larger the DPI the closer the dots gather within the image which will improve the quality of the output but also increase job duration. There will be more pixel density causing more heat to be present at the material as well.

**Fixed Size X:** When checked, the width of the dynamic photo will be set to an appointed size. When unchecked, the photo will remain the original size.

**Fixed Size Y:** When box is checked, the height of the dynamic photo will be set to an appointed size. When unchecked, the photo will remain the original size.

**Fixed Position:** Determines the position of the image when changing image sizes.
**Invert:** When checked, the system will show the negative image of a photo as shown:

![Negative Image Example](image1.png)

**Gray:** When checked, it will convert the selected image to grayscale as shown:

![Grayscale Image Example](image2.png)

**Dither:** When checked, the system will utilize a combination of both black and white pixels to simulate a grey image with dots arranged in different densities within the image as shown:

![Dithered Image Example](image3.png)

**Extend:** When selected, it will open another “Bitmap” dialog box as shown:

![Bitmap Dialog Box](image4.png)
**Lighten:** When checked, it will allow you to adjust the selected image’s brightness and contrast values.

**Scan Mode**
- **Bidirectional Scan:** When checked, the laser will mark the image bidirectionally.
- **Drill Mode:** When checked, it will allow you to control whether the laser is kept on or restricted for a specific duration per pixel during the marking process.
- **Pixel Power Adjust:** When selected, the laser's power is adjusted according to each pixel’s “grey level” when in the marking process.

**Scan Mode Extend:** When the “Extend” button is selected, the following dialog box will appear:

![Scan Mode Extend Dialog Box](image)

- **Y Scan:** When checked, the marking process will follow the Y axis line by line.
- **Scan Line Increment:** When checked, user will be able to specify the marking process to scan line by line, or skip lines by setting a specific increment. This function will speed up the marking process for low precision marking jobs.
- **Disable Mark Low Gray Point:** When checked, user will be able to specify a specific B/W Threshold setting the laser marking process will follow. The settings range between 1 (white) to 255 (black).
- **Line Feed Malposition:** With this box checked, user can control where the marking process marks line by line.
- **BiDir Offset:** Set the offset from the outline of the image.
- **Optimize Mode:** When checked the software calculates the marking speed according to the DPI and frequency to optimize the marking speed and results of the mark.
VECTOR TOOL
This tool will allow you to import a premade vector design into the workspace. You can also import vector images within the Draw Menu as well as the File Menu. Once this icon is selected the following dialog box will appear:

Marker currently supports the following vector file formats: PLT, DXF, DST, SVG

NOTE: If the vector file includes color within the design, Marker is capable of distinguishing the colors automatically. From there you will be able to pick the object according to the Pen. color and set parameters per Pen.

Once a vector image is present the following will be located under the Object Properties:

Optimize Curve: With this box checked, the system will optimize the image for best output.

Auto Connect Curve: With this box checked and applied, the system will connect lines automatically within the design.

Dynamic File: Assign a fixed size for both the X and Y of the vector image as well as assign fixed coordinates.
BARCODE TOOL
This tool will allow operators to create barcodes out of text. To use the tool select the correct icon and then click once on the workspace. Once you create the barcode and select it the following toolbar will appear under Object Properties:

**Barcode Text Function**
Users may specify the barcode font as one of the five font types as shown:

When users select a type of barcode, a list of available barcodes within that font type will appear as BarCode Font, as shown:
When a barcode is created in the work area, while this button is selected, it will bring up the barcode properties window as shown:

This portion of the window shows a sketch of what the current barcode will look like before being created.

This portion refers to the text that will be made into a barcode.

This check box determines whether the text the barcode is made out of will be present beneath the barcode, using the following parameters, as shown:

**Font:** Font of correctors to be displayed.

**Text Height:** The height of characters displayed.

**Text Width:** The width of characters to be displayed.

**Text Offset X:** When selected and enabled, the text displayed under the barcode will be aligned towards either the positive or negative coordinates of the X axis.

**Text Offset Y:** When selected and enabled, the text displayed under the barcode will be aligned towards either the positive or negative coordinates of the Y axis.

**Text Space:** Displays the space in between characters.
One-Dimensional Barcode

One-dimensional barcodes consist of one by one bars and spaces. The barcode information is carried by different widths and positions of the bars and spaces within the barcode. The volume this information carries is decided by the width and the precision of the barcode. The wider the barcode is the more bars and spaces are included and therefore more information is carried. This kind of barcode technology is stored through Unidirectional combinations of bars and spaces giving it the name of a one-dimensional barcode. See image of the parameters used to adjust one-dimensional barcodes:

CheckNum: Indicates whether or not the barcode requires a verification code. Users can freely choose which barcode they would like to require a verification code for.

Reverse: Indicates whether or not to reverse the parts that are to be marked into unexpected locations of the object. This function is typically utilized when a barcode being marked appears as a light color after the marking is completed.

Bar Height: The height of the barcode.

Narrow Width: The width of the bar unit. Commonly a one-dimensional barcode consists of bars with four types of widths and spaces with four types of widths, 1/2/3/4. The narrowest bar width indicates the width is unit.

Scale:
   Bar: Used to set the width of one bar.
   Space: Used to set the width of the space between bars.
**Interchar Space:** Some barcodes have distance between characters. This setting controls that distance, as shown:

Quiet: These settings refer to the size of the barcode’s blank area when “Reverse” is checked. The actual size of the blank area is the multiple of the bar unit.

**Two-Dimensional Barcode**

1. PDF417 Barcode: PDF is the abbreviation for Portable Data File. Shown below are examples of a PDF417 Barcode and a Compressed PDF417 Barcode as well as the parameter window after highlighting the barcode and selecting the icon:

    ![PDF417 and Compressed PDF417 Barcodes](image)

    **PDF417**  
    **Compressed PDF417**
Bar Height: The height of the barcode.

Narrow Width: The width of the bar unit.

Rows and Columns: The rows and columns in a PDF417 barcode.

Level: This setting is the Error-Checking Level of PDF417 barcode.

2. Data Matrix Barcode: Data Matrix is a two-dimensional barcode based on Matrix supporting two types- Ecc000-140 and Ecc200. Marker supports Ecc200 currently. Once a Data Matrix barcode is created and selected left click the button and the following menu will appear:

Circle Mode: When checked, the DataMatrix barcode will be present as circles.

Point Mode: with this box checked the DataMatrix barcode will be present as points.

Rect. Mode: with this box checked the DataMatrix barcode will be present as rectangles.
**Narrow Width:** the width of the bar unit as shown below:

Data Matrix barcodes have various fixed sizes that users can choose from. If the smallest size is chosen the system will automatically select the smallest frame to fit all of the text you have typed. Example’s of the fixed barcode sizes are shown below:

3. **QRCODE Barcode:** QRCODE Barcode is another example of two dimensional code format. The character set includes all ASCII values. There are no size restrictions. shown below is an example of a QRCODE Barcode:
TIME-LAPSE TOOL
This tool will allow the user to set a specific time delay for a specific marking process. When the time lapse is specified the following toolbar will appear below the Object Properties:

Wait Time: Set a time in milliseconds for the system to wait before it begins to mark the selected image.

INPUT PORT TOOL
This tool allows users to control the input signal for a specific marking process. Once selected, the following toolbar will appear below the Object Properties:

I/O Control Condition: These settings control a pause feature for the software. The software will pause until the input signal is the same as the I/O control condition.

Message: if checked, then the software will supply a message to the user that can be customized stating instructions.
OUTPUT PORT TOOL
This tool allows users to control the output signal for a specific marking process. Once selected, the following toolbar will appear below the Object Properties:

- : Icon indicates that the system will export a high-level voltage signal when the operation is taking place at the current output port.
- : Icon indicates that the system will export a low-level voltage signal when the operation is taking place at the Current output port.
- : Icon indicates that the system will export a fixed-level.
- : Icon indicates that the system will export a pulse.
Array
With an object selected click on “Array…” and the following dialog box will appear:

**Rectangle:** Parameters for rectangular array.

**Circle:** Parameters for circular array.

- **Array x**
- **Array y**
- **Array x**
- **Array y**

**Calculate by Offset Distance:** space within graph is calculated by offset distance.

**Calculate by Graph Distance:** space within graph is calculated by graph distance.
Graphs array can be set to clockwise or counterclockwise.

**Array Number:** Number of circles.

**Radius:** Radius of circle(s).

**Start Angle:** Angle between starting objects within graph.

**Angle:** Angle between two objects within graph.

**Transform**
With an object selected click on “Transform” and the following dialog box will appear:

**Move**

: Stroll tool for moving objects.

**Position:** Coordinates of the current object’s selected datum setting.

: Datum setting of an object.

**Relative Position:** Use relative coordinates when checked.

**Apply to Copy Object:** When selected you can copy the current selected object and move it into a new place.

**Apply:** Activates any modifications once selected.
**Rotate**

Rotate your object. Once selected the above window will appear.

**Angle**: Angle to rotate.

**Center**: Coordinates of the current selected object's datum setting.

**Mirror**

Mirror the current selected object. When selected a dialog box will appear.

**Scale**: Zoom ratio after X/Y scale has been mirrored.

**Vertical mirror of current object**.

**Horizontal mirror of current object**.

**Zoom**

Controls the zoom onto your objects. When selected, a dialog box will appear.

**Size**: Size after zooming.
**Lean**

: When selected the user can control an object’s lean angle.

**Shear:** These settings control the angle at which the object will lean.

---

**Plastic**

With an object highlighted you can select the Plastic function and a dialog box will appear:

: Joins two close intersected areas into one.

: Shears a closely intersected area contained in another.

: Isolates the intersected portion of two close intersected objects.
**Distribution**
This setting allows you to select 3 or more objects and distribute them within the work area. Once objects are highlighted select “Distribution” and a dialog box window will appear:

- Distribute left and right, depending on the left line.
- Distribute left and right, depending on center line.
- Distribute left and right, depending on distance between two objects.
- Distribute left and right, depending on the right line.
- Distribute up and down, depending on top line.
- Distribute up and down, depending on the center line.
- Distribute up and down, depending on the distance between two objects.
- Distribute up and down depending on bottom line.

**Trim**
This function when selected will allow you to trim specific portions of objects.

**Curve Edit**
**Auto-Connect:** When selected, a dialog box will appear:

**Auto-Connect Error:** If the distance between two curves' start and end points is less than the setting present the two curves will be joined into one.
Break Cross Point: When selected, a dialog box will appear:

![Break Cross Point Dialog Box]

The length of the cross point means the length of the cross line portion of the design that was created, as shown:

![Cross Point Examples]

**Align**

This function will only be available when more than one object is selected within the workspace. The “Align” function is used to align the objects the user has selected within the two-dimensional plane. Below are the different ways to align objects:

**Horizontal Alignment:**
- **Left:** All objects align left.
- **Right:** All objects align right.
- **Vertical:** All objects align vertically.

**Vertical Alignment:**
- **Top:** All objects align to the top.
- **Bottom:** All objects align to the bottom.
- **Horizontal:** All objects align horizontally.

**Horizontal and Vertical Alignment:**
- **Center:** All objects align to the center.

**NOTE:** The benchmark to align is according to the last object you select and other objects will align behind it. If you select several objects via “Frame Select” then the system won’t be able to identify which is the last object which can cause unexpected alignment. It is strongly recommended that you select a benchmark object at the end when you want to align several objects.
JSF Font
JSF font is the dedicated font with the Marker software. Users have the ability to build their own JSF fonts. When selected, users will see a dialog box appear. The “Help” window is also shown:

**JSF Font Name:** Name of font needing to be established or modified.

**Char of Graph:** Character that is present within “Preview”.

**Load Char Data:** Load data of specific character within font library. NOTE: The font library and characters already exist.

**Save Char Data:** Replace corresponding characters with the current graph within “Preview”.

**Scale X:** The X-direction scale of the graph within “Preview”. By changing this parameter you can adjust the width of the graph that is designed which stands for the character present. The default value is 1. Increase it and the graph becomes more broad, decrease it and the graph becomes more narrow.

**Scale Y:** The Y-direction scale of the graph within “Preview”. By changing this parameter you can adjust the height of the graph that is designed which stands for the character present. The default value is 1. Increase it and the graph becomes more tall, decrease it and the graph becomes shorter.

**Offset Dist Y:** Y-direction offset of the graph present within “Preview”. The default value is 0. Increase it and the graphic will move up. Decrease it and the graphic will move down.

**Left Side Bearing:** Distance of the left frame of the gray box around the graphic and the left frame of the blue box around the graphic. Shown in “Help” window.

**Right Side Bearing:** Distance of the right frame of the gray box around the graphic and the right frame of the blue box around the graphic. Shown in “Help” window.
“Update Font File” and “Char Kerning” are both disabled until the button is selected to open a dialogue box which will allow you to select the name of the font library you are wishing to amend and then select “OK”. That will load the JSF Font name into the Marker software. The “Update Font File” and “Char Kerning” buttons will now be live. If you select the “Update Font File” button the following dialog box will appear:

**Update Font File**

Font Property

Font Name: Name of character which Font Library file saved.

Double Char Width: Like double byte characters for Chinese and Japanese characters, this setting controls the width of the corresponding character.

Double Char Height: This setting controls the height of the corresponding character.

Single Char Width: Like single byte characters for English characters, this setting controls the width of the corresponding character.

Single Char Height: This setting controls the height of the corresponding character.

Descent Ratio: Percentage of height hereinafter the baseline accounting for the character’s standard height.

Can Be Hatched: This box determines whether or not the specified characters can be hatched.

**Char Kerning**

Input Two Characters: Two characters that need to have the space adjusted.

Char Kerning: Space between two characters that needs to be adjusted.

Save Kerning to File: Save space to character style file.
VIEW MENU CONT.

**Zoom:** Show or hide the Zoom Bar within Marker.

**Ruler/ Gridding/ Guideline:** Controls if the ruler, grid, and guidelines are present within Marker.

**Snap Grid:** Controls if dots created will snap to the grid present or not once created.

**Snap Guideline:** Controls if object snap to the guidelines present when moved around.

**Snap Objects:** Snap an object’s top, center, nodes, circle center, intersect points, etc.

**System Toolbar/ View Toolbar/ Draw Toolbar/ Status Bar/ Object List Toolbar/ Object Properties Toolbar/ Mark Parameters Toolbar:** Marker supports many toolbars to achieve different functions. These toolbars can be displayed or hidden by checking or unchecking the items within the View Menu.

**IO State:** Check current input and output states.

SPECIAL MENU CONT.

**Change Text:** By selecting the “Change Text” function, a dialog box will appear:

![Change Text Dialog Box]

The content present under “Text” is what is to be replaced and the content present under “Change To” is what the content under “Text” will be changed into. The name of the text is replaced but the content of the text does not change.
**IPG MOPA Setting:** Once IPG Setting is selected, a dialog box will appear:  
**NOTICE:** this setting is only used for MOPA systems, not QSWITCH.

By connecting using the “Connect” button it connects the computer to the laser through a serial line for the MOPA systems. The laser can now send status signals to the software like temperature and power state. After the system connects, all the indicator lights above will go from gray to green expressing the state is normal. With MOPA systems you can change the pulse width or pulse duration of the laser’s peak output between 4ns and 200ns. Frequency can be adjusted between 1 and 1000KHz within parameters.
**MARKING PARAMETERS**

**Pen List**
Within the Marker software every object has 256 pens, 0 to 255 numbered, that can be assigned to the object located in the top right portion of the software interface as shown:

- : Indicates if objects will be outputted with the specified pen color selected. Users can customize the pen color by double-clicking the color sticker.
- : Indicates if objects will be marked during the marking process. If the user double-clicks the red star shown above it will turn gray indicating that the corresponding pen will not be marked.

**Color:** Indicates current pen’s color.

- : This bar indicates the parameter application for a specific pen. When a specific color is selected the pen number of the current object will be changed to the parameters that the color stands for.

**Use Default Param:** When checked, the default parameters set within the software will be used. If unchecked the user will be able to specify custom marking parameters.

**Current Pen:** Indicates what pen is set to the object selected.

**Mark Loop:** Indicates how many passes the laser will perform of the current object selected.

**Speed(mm/s):** Indicates the speed the laser will travel when outputted for the object selected.

**Power (%):** Indicates the power the laser will fire at for the object specified. Setting can range from 1-100.

**Frequency(KHz):** Indicates the pulse rate the laser will fire at for the object specified. With a Qswitch system the user can specify 20-200 KHz. MOPA allows 1-1000 KHz.
**Laser On TC:** When the scanhead has to execute a mark the galvo mirrors first have to accelerate to the defined marking speed. At the beginning of this process the galvo mirror will move very slowly which may result in a burn-in effect at the start of the job. To avoid this a delay can be inserted (Laser On TC) at the beginning of each mark. This allows the galvo mirrors to reach a certain velocity prior to the laser firing avoiding the burn-in effect. However, if this setting is too large the first portion of the vector mark can be cut off. Negative values are supported.

**Laser Off TC:** Indicates a delay for the laser shutting down at the end of a mark. Obtaining a proper time can remove a burn-in effect at the end of the job. Negative values are not supported.

**End TC:** This parameter is used to control how long the software will wait at the end of a series of vectors marked. This wait is required due to the software always being “ahead” of the hardware of the laser, and must wait for the hardware to catch up. This delay applies to the end of all vectors in which the laser is to be turned off after it executes the job.

**Polygon TC:** This parameter is used to control how long the software will wait at vector connection points. This wait is required due to the lag time between the software/DAC position and the actual position of the hardware/galvo mirrors. This timer applies to all vectors whose endpoint is also the start point of the next vector. In other words, this timer applies to the end of all vectors in a series of connected vectors, except for the last vector which is controlled by the End TC parameter. Clicking “Advanced” will reveal an advanced parameter dialog box as shown:

### Advanced Marking Parameters

- **Jump Speed:** Set a jump speed of the scanner for the current parameter.

- **Min Jump Delay/Max Jump Delay:** Set a jump delay, once jump is completed, the system will wait for the specified time and then jump to the next time. The specified time is the jump delay. Max or Min delay times depend on the Max Limit Length.

- **Max Limit Length:** Sets the longest length of the jump time to ensure ideal jump result.

**Example:**
For the delay, say the Max Limit Length is set to 10mm, Max Jump Delay is set to 500ms, and Min Jump Delay is set to 100ms. When the actual jump distance is 12mm, the jump delay will be 500ms; When actual jump distance is 5mm, the jump delay = 5/10*(500-100)+100= 300ms. When the actual jump distance is greater than the Max Limit Length, the jump delay will be the Max Jump Delay setting; When the actual jump distance is less than the Max Jump Delay, the jump delay will be the linear interpolation of the Max Jump Delay and Min Jump Delay settings.
**Enable Optimize Mode:** When checked, optimized mode settings will become adjustable.

**Start Length:** Controls the length it takes for the galvos to speed up before the laser begins to mark.

**End Length:** Controls the length it takes for the galvos to slow down while a mark is ending.

**Break Angle:** This setting sets the breaking angle of the output.

Example:
Setting the desired Start Length and End Length parameters can remove mark start and end mark over burn or non-uniform marking. For example, if a rectangle that is 40mm x 20mm is marked, the galvo has a speed up process when it starts, and a slow down process when it stops. During these two processes, commonly a non-uniform mark can occur as illustrated below:

The arrow’s direction indicates the marking direction. The arc present illustrates the break angle. In the illustration above, the angle is 90°. For example, set the break angle to 89°. When marking angle is 89° or larger than 89°, you will see the marking result below:

The perforated lines are the galvo movements without firing while speeding up and slowing down. The former perforated line is welded to the line segments to be marked. With the understanding that the perforated lines are the speed up distance or the slow down distance for the galvos, it will optimize the deep point and arc angle at the corners of the mark.
**Attention:** Start Length and End Length should not be set too high, these parameters should be matched up with the Start TC and End TC settings.

If the Start TC and End TC settings are all 0, the marking result is illustrated below:

![Marking Result](image)

Notice that the perforated indicating the slow down and speed up distances for the galvo are no longer perforated but are solid. This indicates that the laser will mark those lines giving the output seen.

**Wobble**
With Wobble checked, the laser will mark single lines as a spiral that can create more bold/deep marks via the following parameters:

**Diameter:** Sets the width of the “wobble” to control the width of the line being marked.

**Distance:** Sets the center distance between each “spiral” being marked via the “wobble” function. Too large of a value create shading, too small of a value will increase marking time.

**Note:** Adjusting wobble settings can save time during a mark.
If “Select Param From Library” is selected, the following window will appear:

This window allows users to choose from saved parameters as well as save parameters that can be assigned to pens that are intended to be marked.

**Current Param Save As:** Select this button to name the current parameters being used and save them to be used at a later time.

**Delete Select Param:** Select a parameter and then select this button to delete a previously saved parameter.

**Apply to Default:** Select this button and the current parameters specified will now become the default parameters.
Mark-Control Bar
The Mark-Control Bar is located at the bottom of the main software interface as shown:

- **Light**: Used to emit the frame of the object without emitting the laser beam. This allows the end user to orientate the workpiece to align the output of the job. Key “F1” is the shortcut key of this function for the guide light trace.
- **Mark**: Executes marking. Key “F2” is the shortcut key of this function.
- **Continuous**: This command marks the objects repeatedly until the user stops the mark.
- **Mark Selected**: If selected only the selected objects will be marked.
- **Part**: The total counts that the mark command has been executed.
- **Total**: Indicates the total number of marks to be executed. The value will decrease by one automatically after one mark has been executed. This function is unavailable when “Continuous” is selected. When in the marking process, if the number present is more than one, the marking operation will not stop until the number is 0.
- **Parameter**: Machine parameters. Key “F3” is the shortcut key for this function.
**MACHINE PARAMETERS**

**Field Parameter**
Once the machine parameters window is opened via the “F3” key, or the Parameters button, a pop-up screen will appear:

![Configuration Parameters](image)

**Field:** The widest range for marking.

**Galvo 1=X:** Galvo 1 controls the X axis if selected.

**Galvo 2=X:** Galvo 2 controls the X axis if selected.

**Offset X:** Offset distance on X direction of scanhead.

**Offset Y:** Offset distance on Y direction of scanhead.

**Use the Correct File:** Use the file generated by CorFile.exe soft.

**Negate:** When selected, the corresponding galvo will travel in opposite direction.
This item refers to the distortion correction coefficient. The default value for this function is 1.0 and has a range of 0.875 - 1.125. When outputting a square with the light trace feature the square should look, as shown:

If square looks as shown below, then the distortion correction will need to be adjusted:

This item indicates the parallelogram correction coefficient. The default setting is 1.0 and has a range of 0.875 - 1.125. If an outputted square looks like the illustration below it will need to be corrected:
**Scale:** this setting refers to the flex percentage which defaults at 100%. It can be adjusted depending on the light trace size marked being different from the size of the square intended to be marked. If the light trace is smaller than the design the users can raise the scale parameter for the corresponding axis. If the trace is larger than the design the users can lower the scale parameter for the corresponding axis. When setting scale the end user can select and a dialog box will appear:

![Calculate scale dialog box](image)

**Goal Mark Size:** Size of square present within Marker software.

**Real Mark Size:** Measured size of object being outputted by light trace feature. After correcting the values the software will calculate the scale automatically.

**After Mark Go To:** After the mark is completed the galvo will jump to the specified position.
SECTION FIVE: TESTS AND CALIBRATION

It is important that your laser is tested and calibrated (if needed) for proper use before you start your first job. The fiber systems are pre-calibrated before being shipped out, however, if the laser is experiencing issues upon arrival it is recommended to confirm calibration.

WORK SPACE CALIBRATION (163 F Theta)

Step One: Confirm Proper Scale Output

A) First, confirm is that the laser is outputting at the correct scale. To do this, have the Marker application running and select the Rectangle Tool and click-drag-drop on the work surface in Marker to create a square. Once drawn, locate the “Object Properties” of the square on the left side of the window located under the “Object List”. Type in 0 for the X coordinate and 0 for the Y coordinate and then specify the “Size” of the square to be 110mm x 110mm and then select “Apply”. This will set the square to 110mm and center it within the work area as shown:

B) The next step in the process is to confirm that the created square is being emitted at 110mm. Once the square is created as shown above ensure that the F Theta Lens is the proper distance from the work area to be in focus. Once in focus select the F1 key or the “Light” button located at the bottom of the Marker software. This will tell the machine to perform a light trace of the 110mm square onto the work area. Use the provided ruler to measure both the X and Y scale of the square as shown:
C) If the square is emitted at 110mm then this stage of calibration is completed and the user can move on to the next stage. If it does not emit at 110mm then you will need to calibrate the laser to emit at the correct scale. To do this, select the F3 key within Marker or select the “Parameters” button at the bottom of the software. The following window will appear:

![Configuration Parameters window](image)

D) The Field tab will allow you to make the necessary adjustments to the scale of the square when emitted. First confirm that the “Field Size” is 110mm. G) Next confirm that Galvo 2 is checked as the X axis located to the right of the “Field Size” option. From there refer to the Galvo 1 and Galvo 2 segments of the window. Before you make any adjustments you will want to negate the axis that you do not wish to change at that time. Start with negating the Y axis or “Galvo 1” and then select the [ ] on the X axis side or “Galvo 2” as shown below:

![Field tab settings](image)

E) When the [ ] is selected and the above window appears the end user will enter the “Goal Mark” which with the 163 F Theta lens will be 110mm and then specify the “Real Mark Size” that was obtained in the X axis using the provided ruler. Select OK and that will automatically adjust the scale of the emitted laser. Once OK is selected uncheck the Negate box for “Galvo 1” and then check the Negate box for “Galvo 2”. Select the [ ] button for “Galvo 1” and enter 110 as the “Goal Mark Size” and specify the “Real Mark Size” that was obtained in the Y axis using the provided ruler and select OK. Once OK is selected uncheck the Negate box for “Galvo 2” and then select OK on the window. Press the F1 key again and measure the output of the 110mm square. The square should now be 110mm in both the X and Y axis’.
Step Two - Red Light Trace Accuracy Confirmation.
A) The next step in the calibration process is to confirm that the red light trace feature is lining up with the output of the fiber system. To do this the user will want to create a 10mm square within Marker and center it as shown:

B) Once the 10mm square is created have the provided anodized aluminum card present within the work area and the focus lens focused to the surface of the card. Perform a light trace via the fn + F1 keys, align the material with the red light to where you intend to output the square, press enter and then mark the square via the fn + F2 keys or the “Mark” button located at the bottom of the software screen. The mark will be made at the default marking parameters as illustrated:
C) Once the mark is made you will want to ensure the card is not moved and then select the fn + F1 key to trace the square onto the material. The user will want to confirm that the red guide light is overlapping the square that was marked on the material. Shown below is an example of negative output:

![Image of negative output]

D) If the red trace lines up with the marked square then this stage of testing/calibration is completed. If the red trace is offset from the mark made the user will need to calibrate the output. Do that by selecting the fn + F3 key or “Param” button located at the bottom of the software. Once selected the following window will appear:

![Configuration Parameters window]

After Mark Goes:
- No Move
- Galvo Center
- Left Up
- Right Up
- Right Bottom
- Left Bottom
- Special pos.
- X: 0.000
- Y: 0.000

Password Input
E) Once the window above is present select the “Other” tab which will display the following:

![Configuration Parameters](image)

F) With that window present select “Red Light Pointer” located on the right side of the window under “Fly Mark”. Once selected the following window will become present:

![Red light pointer](image)
**G** This window will allow the user to adjust the red light offset that is present during output. Offset Pos X and Offset Pos Y settings are what control the output. If the red light function is offset to the right in the X axis from the mark then the user will want to lower the value or specify a negative value in the Offset Pos X setting. Select OK and check the adjustment by performing a trace of the square again. Perform that step until the X axis is ideal and then move on to the Y axis. If the red trace is above the mark made then the user will want to lower the value or specify a negative value in the Offset Pos Y setting. If the red trace is lower than the mark then the value will need to be raised. Adjust those two settings until the red trace is overlapping the mark as shown:

![Red light trace](image)

**H** Once you ensure that the red light is tracing the output correctly the last confirmation for the square will be to ensure that the square is indeed 10mm using the ruler provided.

That completes calibration.
Replacing Lenses

There are three F Theta lenses available for the FD system: The 163 F Theta, the 254 F Theta, and the 330 F Theta. The 163 F Theta comes with the FD machine standard and the 254 and 330 F Theta lenses can be obtained as an optional accessory. The 163 F Theta lens will have a smaller spot size and work area then the 254 and 330. If a larger work area is desired a 254 or 330 F Theta lens will need to be obtained and installed. The following covers how to remove the current lens and install a new F Theta lens:

**Step 1:** Remove Current Lens. Remove the current lens that is installed. Confirm that the lens cap is installed to avoid damaging the optic. With one hand, hold the lens collar that the F Theta lens threads into, and with the other hand, begin to turn the F Theta lens clockwise when referring to the top of the scan head down to unscrew the lens as shown:

Step 2: Install New Lens. Once the original lens is removed, ensure that it is stored in an area where dust will not accumulate on the optic. Ensure that the top protective lens cap is removed from the new F Theta lens and begin threading the lens into the lens collar by turning the lens counter-clockwise until secured.

**Step 3:** Find New Focus. The new 254 F Theta lens will have a focal depth of 264mm on the focus stand to focus the beam to the base plate within the system. Follow the same focusing procedure depending on the thickness of the material.
No Red Light In Work Area

There are several variables that can cause the red light diode to not be present. First, ensure that the fiber machine is powered on by confirming the power cord is plugged in and flipping the breaker switch on the right side of the laser system up. The end user should hear the component fans within the machine turn on. If the red light is still not present within the work area ensure that the lens cap is removed from the scan head as that can potentially be blocking the red light.

If the lens cap is confirmed to be removed ensure that the laser source is turned on by pressing the white button located on the front dashboard of the laser system. The button will light up white when powered on. If red light is still not present within the work area then the last thing to check is to ensure that the “Infrared” emission knob is turned clockwise until the red light pointer is turned on.

If red light is still not present contact tech support.

Demo Mode

The Marker software can boot into two different modes. Demo mode or the standard operating mode. The only time the Marker software will boot into Demo mode is if the software cannot detect the laser system prior to being opened. Demo mode will be present within the Marker software as shown below if the software cannot locate the Fiber marking machine:
While in Demo Mode the end user may import designs or create new designs, however, they will not be able to save any designs created or changes made to imported designs. Demo Mode is a quick way to import designs and ensure that they are compatible with the software prior to establishing a connection with the laser. In order to avoid booting up in Demo Mode the end user will need to ensure that the Fiber Marking machine is connected to the PC that has the Marker software installed onto it. On the interior of the machine a Type A to Type B USB cord will be present from the controller to the PC. With the USB cord connected from computer to fiber system the laser will then need to be powered on. Once powered on the Marker software can now be opened and it will boot into the standard operating mode.

If the USB cord is connected and laser powered on the Marker software is still showing Demo Mode then the machine can be turned off and USB cord reseated at the control card. Once reseated attempt to establish a connection with the laser unit again. If Demo mode is still present contact tech support.

Some FD models will have the controller present within the PC tower. No USB cord will be present if that is the case. If Demo mode is present with a machine that has the controller located within the PC tower contact tech support.

General Maintenance

FD Fiber Laser Markers require very little maintenance, however, the following is recommended:

**Keep Working Space Clean and Clutter Free.** Keeping your workspace clean and free of clutter helps increase safety.

**Keep Marking Area Clear of Debris:** Keep the marking area clean and free of debris by vacuuming or wiping the area with a clean rag after each use.

**Clean Lens:** The lens is far from the material and so will not typically need to be cleaned after each job. Depending on workflow, check and clean your lens weekly. Use only non-abrasive optic wipes when cleaning the lens.

**Keep Your Fire Extinguishers Current:** Inspect your workspace fire extinguishers and replace any that have gone past their maximum efficiency date.
Appendix A: Software Download for Replacement Laptop/PC

The FD system comes with a Lenovo PC that already has the Marker software installed. If for any reason the software is uninstalled from the PC or a replacement computer is needed to be obtained, the end user will need to contact FSL support directly to obtain a copy of the software. The following covers how to install the software and drivers onto a new laptop or PC:

Once the folder containing the software is received, download the entire folder onto the desktop of your laptop/PC.
Connect the fiber system to the laptop/PC via the provided USB cable.
Turn on fiber system
Open the “Software” folder located in the folder that was copied to your desktop.
Open the “Marker 2.7.6” folder located in the Software folder.
Run the “Marker 2.7.6.exe” application.

NOTE: If you are getting a Softdog error, you want to make sure that ALL the files were extracted to your computer properly. Open Software> Marker 2.7.6? Right click the Marker application and make a shortcut to your desktop. You will then be able to run this shortcut without any issues.

The drivers more than likely will not be installed so when the user opens the Marker software an LMC error of “Failed to open lmc driver” and “Can not find a valid lmc driver” will appear. Hit OK for both of those errors.
From there open the Device Manager to your computer.
Under “Other Devices” you should see “USBLMCV2” with an error since the fiber system is still turned on and connected to the computer.
Right click “USBLMCV2” and select “Update Driver Software” and then select “Browse my computer for driver software”.
Select the “Browse...” button to search your computer for the driver and then follow this path: Desktop/Fiber Software and Manual/ Fiber Driver and select OK. That will load the driver and install “Laser Mark Control Board V2 [USB].
Close the Device Manager as well as the Marker software and reopen the Marker software with the fiber still turned on and connected. You should no longer receive any errors.

Some FD models will have the laser controller installed into the PC tower directly. If the controller is installed into the PC tower and the computer malfunctions or needs to be replaced, contact tech support.
Appendix B: Rotary Attachment Installation (Optional)

The FD system has an optional rotary attachment that can be purchased and installed into the FD system used to mark on cylindrical objects. The following instructions cover how to install the rotary attachment onto your machine:

First, ensure that the machine is powered down and the workspace is clear of all material and debris as shown:

With the work area cleaned the rotary attachment can be set up on the left side of the workspace. Ensure to align the rotary attachment so that it is centered within the left side of the workspace and is perpendicular to the scan head of the fiber system as shown:
From there ensure that the hole ports in the bottom mounting plate of the rotary attachment are aligned with the threaded hole ports within the workspace and use the provided screws and a 5mm hex key to secure the rotary attachment to the work area as shown:

With the rotary attachment secured to the workspace, it can now be hooked up to the motion control system. To do this use the provided cord and attach one end to the rotary attachment via a white connector as shown:
The white connector attached to the rotary attachment run the other end of the cord to the rear of the machine to attach and secure the cord to the “Motion” port located on the rear bottom of the fiber system. Once plugged in thread the collar of the attachment to the port securing it in place as shown:

The rotary attachment is now installed into the fiber system. Use the provided “T” tool to open and close the jaws of the rotary as shown:

This concludes the rotary attachment installation.
Appendix C: Warranty Information

Warranty

Within the first 30 days, Full Spectrum Laser will replace or repair any defective parts free of charge and pay for ground shipping of parts if you paid FSL for shipping. Overnight shipping is available at extra charge. If you picked up in person or used your own shipping methods, FSL considers the parts to be sold FOB our warehouse and you must arrange your own shipping or pickup replacement parts as FSL did not make the original shipping arrangements.

Outside the first 30 days, Full Spectrum Laser will replace or repair any defective within the warranty period free of charge but shipping charges are the responsibility of the customer. The warranty includes parts and labor only. Shipping of defective and replacement components is excluded by the warranty. The customer may arrange their own shipping or drop parts off to exchange parts at our warehouse free of charge. Typically Full Spectrum Laser has most replacement parts on hand for immediate shipment of under warranty parts.

All defective parts must be returned to Full Spectrum Laser postage paid for evaluation before replacements are issued unless otherwise authorized. The warranty is valid for normal use only and excludes Acts of God, user error and use outside of normal parameters. Parts damaged by fires are considered user error if the machine is left unattended. Just like operating a household gas stove, always stand next to the machine with a fire extinguisher and be ready to turn it off in case of a fire and never operate the machine unattended.

The Hobby lasers have a 60 day warranty on all items and a free extended limited 1 year warranty which excludes consumable items/shipping included in their price. The ProLF lasers have a 90 day warranty on all items and a free extended 1 year warranty which excludes consumable items/shipping included in their price.

3D Printers have a standard 1 year base warranty that covers all parts/labor (including laser diode, galvos, motors, electronics) except consumables (build plate, resin, VAT) and shipping/handling. 3D printers do not come with an accuracy guarantee but are designed for full end user calibration/adjustment. 3D Printer and 3D Printer software license may be only be used in conjunction with authorized consumables from FSL3D. After market consumables are not supported and may damage your printer, void your warranty/software license. Due to the increase reliability data using FSL's RetinaEngrave controller, ProLF lasers purchased and shipped with RetinaEngrave have a 2 year limited warranty (excludes shipping) on the RetinaEngrave controller portion of the laser.

Replacement parts purchased separately from machines have a 90 days warranty excluding shipment.

The limited warranty excludes shipping and consumables and other normal wear and tear items. All electronic items (control cards, power supplies, motors) and most mechanical items are covered under the extended warranty unless damaged by abuse/fires. Consumables not covered include, but not limited to, rubber parts such as tubing, belts, plastic wheels, lenses, mirrors, other optics, and laser tubes.

Within the first 30 days the original purchaser may transfer the balance of your warranty to anyone else free of charge provided you notify us in writing. Outside of the first 30 days, we will only provide warranty and tech support services to the original purchaser unless a warranty transfer fee is paid as there is a cost involved with initial tech support of new users and accounting fees. If you sell your machine, the warranty remains valid but the buyer must arrange with the original purchaser to request RMAs and send in the machine for repairs unless a warranty transfer fee is paid.